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การเขยีนโปรแกรมเป็นทกัษะพื้นฐานส าคญัในโลกปัจจุบนั ที่ซึ่งเทคโนโลยแีละซอฟต์แวร์มบีทบาท
ส าคญัในทุกอุตสาหกรรม VB.NET เป็นหน่ึงในภาษาโปรแกรมทีไ่ดร้บัความนิยมจากนักพฒันาโปรแกรม
ทัง้มอืใหม่และมอือาชพี ดว้ยความสามารถในการพฒันาแอปพลเิคชนัหลากหลายรปูแบบ ทัง้ Desktop, 
Web และ Mobile โดยอาศยั .NET Framework, .NET Core และ .NET 5+ ทีม่ปีระสทิธภิาพและความ
ยดืหยุน่สงู 

หนังสอืเล่มนี้ถูกออกแบบขึน้เพื่อช่วยให้ผู้เริม่ต้นเรยีนรู ้VB.NET อย่างเป็นระบบ เริม่ตัง้แต่
ความเขา้ใจพืน้ฐานเกี่ยวกบัภาษา การตดิตัง้เครื่องมอือย่าง Visual Studio หรอื Visual Studio Code 
ไปจนถงึการสรา้งโปรเจก็ต์แรกแบบ Console Application บทแรก Introduction to VB.NET จะพา
ผูอ่้านท าความเขา้ใจกบัประวตัแิละววิฒันาการของ VB.NET ความแตกต่างจาก VB6 รวมถงึแนวคดิ
เกีย่วกบั .NET Framework, .NET Core และ .NET 5+ ซึง่เป็นรากฐานส าคญัก่อนทีจ่ะเริม่เขยีนโคด้ 
ต่อจากนัน้หนงัสอืจะพาผูอ่้านเขา้สู่ Basic Syntax ซึง่เป็นหวัใจของการเขยีนโปรแกรมใน VB.NET โดย
อธิบายโครงสร้างโปรแกรม เช่น Module และ Sub Main การเขียนค าสัง่แสดงผลด้วย 
Console.WriteLine การรบัค่าจากผูใ้ชด้้วย Console.ReadLine และการเขยีนคอมเมนต์อย่างถูกต้อง 
เพื่อใหโ้คด้อ่านงา่ยและสามารถบ ารงุรกัษาไดส้ะดวก 

เมื่อเขา้ใจโครงสรา้งพืน้ฐานแลว้ ผูอ่้านจะไดเ้รยีนรูเ้รื่อง Variables & Data Types ซึง่เป็นส่วน
ส าคญัของการเกบ็และจดัการขอ้มลูในโปรแกรม ครอบคลุมชนิดขอ้มลูพื้นฐาน เช่น Integer, Double, 
Boolean, String, Char และ DateTime พรอ้มทัง้การประกาศตวัแปรดว้ย Dim, Const และ Static และ
การแปลงชนิดขอ้มลูดว้ยฟังกช์นั CInt, CDbl, CStr เพื่อใหส้ามารถประมวลผลขอ้มลูไดอ้ย่างถูกต้องและ
ปลอดภยั 

หลงัจากนัน้ หนังสอืจะน าเขา้สู่หวัขอ้ Operators และ Control Flow ทีช่่วยให้โปรแกรม
สามารถค านวณและตดัสนิใจตามเงื่อนไขต่าง ๆ ไดอ้ย่างมรีะบบ ครอบคลุม Arithmetic, Comparison, 
Logical และ Assignment Operators รวมถงึโครงสรา้งการควบคุม เช่น If / ElseIf / Else, Select 
Case, For Loop, For Each Loop, While, Do While, Do Until และการใช ้Exit และ Continue เพื่อ
จดัการลปูและเงือ่นไขอยา่งเหมาะสม 

บทต่อไปจะกล่าวถงึ Functions & Procedures ซึง่ช่วยใหน้ักพฒันาสามารถจดัระเบยีบโคด้ 
แยกงานเป็นส่วนยอ่ย และใชง้านซ ้าไดอ้ยา่งมปีระสทิธภิาพ โดยอธบิายความแตกต่างระหว่าง Sub และ 
Function การส่งค่าแบบ ByVal และ ByRef การใช ้Optional Parameters และ Default Values รวมถงึ
การส่งค่ากลบัดว้ย Return Values ทัง้หมดน้ีจะช่วยใหผู้อ่้านสามารถสรา้งโปรแกรมทีม่โีครงสรา้งชดัเจน 
อ่านงา่ย และบ ารงุรกัษาไดง้า่ย 

หนงัสอืเล่มนี้ยงัมตีวัอยา่งบรูณาการในแต่ละบท เพื่อใหผู้อ่้านไดฝึ้กเขยีนโปรแกรมจรงิและเขา้ใจ
หลกัการท างานของโคด้ในบรบิทต่าง ๆ การฝึกปฏบิตัจิะช่วยสรา้งความมัน่ใจและความเชีย่วชาญในการ
เขยีนโปรแกรม VB.NET ตัง้แต่ระดบัเริม่ตน้จนสามารถต่อยอดไปสู่การพฒันาแอปพลเิคชนัขัน้สงู 



ทา้ยที่สุด ผู้อ่านทีศ่กึษาเนื้อหาในหนังสอืเล่มนี้จะไดร้ากฐานที่ม ัน่คงในภาษา VB.NET เขา้ใจ
หลกัการเขยีนโปรแกรมอย่างเป็นระบบ และสามารถสร้างโปรแกรมที่มตีรรกะชดัเจน มปีระสทิธภิาพ 
และพรอ้มต่อการพฒันาต่อในโลกของเทคโนโลยสีมยัใหม ่หนงัสอืเล่มนี้จงึเหมาะส าหรบัผูเ้ริม่ต้นทุกคนที่
ตอ้งการเขา้ใจ VB.NET อยา่งลกึซึง้และพรอ้มน าไปใชง้านจรงิ 

ดว้ยรกัและปรารถนาด ี
ศนูยห์นังสือรำคำนักเรียน 
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บทท่ี 1 
Introduction to VB.NET 
(Introduction to VB.NET) 

 
เน้ือหา  
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บทน า: Introduction to VB.NET 
Visual Basic .NET (VB.NET) เป็นหนึ่งในภาษาการเขยีนโปรแกรมเชงิวตัถุทีพ่ฒันาขึน้โดย Microsoft 
เพื่อเป็นภาษารุ่นใหม่ทดแทน Visual Basic 6 (VB6) ซึง่ไดร้บัความนิยมอย่างแพร่หลายในช่วงปลาย
ทศวรรษ 1990 และต้นปี 2000 VB.NET ถูกออกแบบใหส้ามารถท างานร่วมกบั .NET Framework ได้
อย่างเต็มประสทิธภิาพ พรอ้มรองรบัแนวคดิการพฒันาโปรแกรมสมยัใหม่ เช่น การเขยีนโปรแกรมเชงิ
วตัถุ (OOP) และการจดัการขอ้ผดิพลาดเชงิโครงสรา้ง 

ความแตกต่างส าคญัระหว่าง VB6 และ VB.NET อยู่ที่โครงสรา้งและความสามารถของภาษา 
VB.NET ได้รวมแนวคดิของ .NET Framework ท าให้สามารถใช้คุณสมบตัขิ ัน้สูง เช่น การจดัการ
หน่วยความจ าอตัโนมตั ิ(Garbage Collection), การสนับสนุนชนิดขอ้มลูทีป่ลอดภยั (Strongly Typed 
Data) และการเขา้ถงึคลาสและไลบรารมีาตรฐานของ .NET ไดโ้ดยตรง 

นอกจาก .NET Framework เดมิแลว้ Microsoft ยงัไดพ้ฒันา .NET Core และล่าสุดคอื .NET 
5+ ซึง่เป็นแพลตฟอรม์แบบขา้มระบบปฏบิตักิาร (Cross-platform) ทีร่องรบัการสรา้งแอปพลเิคชนัทัง้
บน Windows, macOS และ Linux VB.NET จงึสามารถน าไปใชส้รา้งโปรแกรมไดห้ลากหลายประเภท 
ตัง้แต่แอปพลเิคชนัเดสกท์อ็ป ไปจนถงึเวบ็และบรกิารบนคลาวด์ 

การเริม่ต้นใชง้าน VB.NET จ าเป็นต้องตดิตัง้เครื่องมอืพฒันา (IDE) เช่น Visual Studio หรอื 
Visual Studio Code ซึง่ทัง้สองรองรบัการสรา้งโปรเจก็ต์ VB.NET ไดส้ะดวก Visual Studio ใหฟี้เจอร์
ครบครนัส าหรบันกัพฒันาทีต่อ้งการเครือ่งมอื GUI แบบเตม็รปูแบบ ขณะที ่Visual Studio Code เหมาะ
ส าหรบัผูท้ีต่อ้งการ IDE ขนาดเบาและสามารถปรบัแต่งได ้
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บทแรกนี้จะพาผูอ่้านเรยีนรูต้ ัง้แต่การตดิตัง้และตัง้ค่า Visual Studio จนถงึการสรา้งโปรเจก็ต์แรกของ 
VB.NET ซึง่เป็น Console Application การเรยีนรูก้ารสรา้งโปรแกรมคอนโซลจะช่วยใหเ้ขา้ใจพืน้ฐาน
ของโครงสรา้งโปรแกรม การเขยีนค าสัง่ และการรนัโปรแกรมบน IDE ไดอ้ยา่งมัน่ใจ 

นอกจากนี้ยงัมกีารอธบิายพืน้ฐานของ .NET Framework, การเรยีกใชค้ลาสมาตรฐาน และการ
ท างานของคอนโซลอย่างละเอยีด เพื่อใหผู้้อ่านสามารถพฒันาความเขา้ใจอย่างเป็นระบบ และสามารถ
ต่อยอดไปสู่การพฒันาแอปพลเิคชนัแบบกราฟิก (GUI) และแอปพลเิคชนัเวบ็ในบทต่อไปได ้

ด้วยความสามารถและความยดืหยุ่นของ VB.NET บทนี้จงึเป็นจุดเริม่ต้นที่ส าคญัส าหรบั
นกัพฒันาทุกระดบั ไมว่่าจะเป็นผูเ้ริม่ต้นหรอืผูท้ีม่พีืน้ฐาน VB6 อยู่แลว้ การเขา้ใจประวตั ิความแตกต่าง 
และการใช้งานเบื้องต้นของ VB.NET จะช่วยสรา้งรากฐานที่แขง็แรงส าหรบัการพฒันาโปรแกรมขัน้สูง
และการใชเ้ทคโนโลย ี.NET รุน่ใหมใ่นอนาคต 

 
Introduction to VB.NET 

 ประวตัแิละววิฒันาการของ VB.NET 
 ความแตกต่างจาก VB6 
 .NET Framework, .NET Core และ .NET 5+ 
 การตดิตัง้ Visual Studio / Visual Studio Code 
 การสรา้งโปรเจก็ตแ์รก (Console Application) 

 
บทท่ี 1: Introduction to VB.NET 
1) ประวติัและวิวฒันาการของ VB.NET 

 จดุก าเนิด: VB.NET เกดิในยคุ .NET 1.0 (ประมาณปี 2002) เพื่อสบืทอดจาก Visual Basic 6 
(VB6) แต่ยกระดบัใหเ้ป็นภาษา Object-Oriented เตม็รปูแบบ ท างานบน CLR (Common 
Language Runtime) และเขา้ถงึ Base Class Library (BCL) ของ .NET ไดท้ัง้หมด 

 ยคุ .NET Framework: ช่วง .NET 2.0–4.x เพิม่ฟีเจอรส์ าคญั เช่น Generics, LINQ, 
Async/Await, รวมถงึไลบรารจี านวนมาก (WinForms/WPF/ASP.NET) 

 ยคุ .NET Core และ .NET 5+: Microsoft รวมแบรนดเ์ป็น “.NET” (เริม่จาก .NET 5) ปัจจบุนั
คอืสาย cross-platform (Windows, macOS, Linux) เน้นประสทิธภิาพสงู โครงสรา้งโปรเจก็ต์
แบบ SDK-style และเครือ่งมอืสมยัใหม่ 

 สถานะปัจจบุนั: VB.NET ยงัรองรบับน .NET ส าหรบังาน Console, Class Library, 
WinForms, WPF (บน Windows) และงาน Enterprise/Legacy ทีต่อ้งการความเสถยีร แม้
จงัหวะเพิม่ฟีเจอรภ์าษาใหม่จะชา้กว่า C# แต่ยงัคง Stable & Supported ส าหรบังาน
เดสกท์อ็ปและระบบองคก์ร 
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2) ความแตกต่างจาก VB6 (ส่ิงท่ีควรรู้เวลาเปล่ียนมา VB.NET) 

ประเดน็ VB6 VB.NET 

รนัไทม ์ COM/ActiveX CLR (.NET Runtime) + BCL 

Paradigm 
Event-driven, OOP ไม่
เตม็รปูแบบ 

OOP เตม็รปูแบบ (Class, Inheritance, 
Interfaces, Generics) 

ชนิดข้อมลู 
Variant ใชก้นัแพรห่ลาย, 
Integer = 16 บติ 

Strongly-typed, Integer = 32 บิต, แทน Variant 
ดว้ย Object/ชนิดทีช่ดัเจน 

ข้อผิดพลาด On Error GoTo ... Try … Catch … Finally, Throw Exceptions 

UI Tech VB6 Forms WinForms / WPF 

Deploy 
ลงทะเบยีน COM, DLL 
Hell 

XCOPY/ClickOnce/MSIX, จดัการแพก็เกจผ่าน 
NuGet 

อาเรย ์ อาจเริม่ที ่index 1 ปกต ิเร่ิมท่ี 0 

ดีฟอลตพ์รอ็พเพอรตี์ ม ีdefault properties มาก ตดั default properties ออก → โคด้ ชดัเจนกว่า 

มลัติเธรด จ ากดั Tasks/Async-Await, TPL 

กบัดกัยอดฮิตตอน
ย้ายมา .NET   

 Integer ของ VB.NET คอื 32 บติ (เท่า Long ของ VB6) → ระวงัการแปลงชนิด 
 หลกีเลีย่งการพึง่พา default properties/late binding; เปิด Option Strict On เสมอเพื่อความ

ปลอดภยัและประสทิธภิาพ 
 โครง UI และอเีวนตใ์น WinForms/WPF มรีปูแบบ event/delegate ต่างจาก VB6 

 
3) .NET Framework, .NET Core และ .NET 5+ (ปัจจบุนัเรียกรวมว่า “.NET”) 

 .NET Framework (4.x): รนับน Windows เท่านัน้ เหมาะกบัระบบองคก์ร/เดสกท์อ็ปทีย่งัผกู
กบั Windows API และเทคโนโลยเีดมิ 

 .NET Core → .NET 5+ (เรียกรวม “.NET”): 
o สาย Cross-platform, เรว็ ประหยดัหน่วยความจ า, รองรบั self-contained publish 
o โครงสรา้งโปรเจก็ตแ์บบ SDK-style งา่ยต่อการจดัการแพก็เกจดว้ย NuGet 
o VB.NET บน .NET ปัจจบุนั: รองรบั Console, Class Library, WinForms, WPF 

(Windows) 
o ASP.NET Core อยา่งเป็นทางการ ไม่มีเทมเพลต VB (นิยมใช ้C#) แต่ VB library 

น าไปอ้างองิในโซลูชนั C# ได ้
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 เลือกใช้เม่ือไรดี 
o ถา้สรา้งระบบใหม่/ตอ้งการยา้ยสู่อนาคต → เลอืก .NET (5+) 
o ถา้ระบบเดมิพึง่พา .NET Framework/COM/Windows-only หนกัมาก → อาจอยู่บน 

.NET Framework ต่อจนกว่าจะวางแผนยา้ย 

 
4) การติดตัง้เคร่ืองมือ: Visual Studio / Visual Studio Code 
ทางเลือก A: Visual Studio (แนะน าส าหรบั VB.NET) 
เหมาะสุดส าหรบั WinForms/WPF/Designer และ Debugger ทีส่มบรูณ์ 

1. ดาวน์โหลด Visual Studio Community (ฟรสี าหรบับุคคล/ทมีเลก็) 
2. ตอนเลอืก Workloads ใหต้ิก๊: 

o .NET desktop development (จ าเป็นส าหรบั WinForms/WPF/Console) 
o (ทางเลอืก) Data storage and processing ถา้จะเชื่อมฐานขอ้มลู/SSDT 

3. หลงัตดิตัง้ คุณจะได ้Designer, IntelliSense, Windows Form Designer, WPF Designer, 
Debugger ครบถว้น 

ทางเลือก B: Visual Studio Code 
 เหมาะกบั Console/Class Library และงานแกไ้ขโคด้เบือ้งตน้ 
 ตดิตัง้ .NET SDK และส่วนขยายทีเ่กีย่วขอ้ง (เช่น C# Dev Kit ใชช้่วยเรือ่งดบีกั/เทสตร์ะดบั

หนึ่ง) 
 หมายเหตุ: ภาษา VB ใน VS Code ยงัไม่มีภาษาเสริมท่ีสมบูรณ์แบบเท่า C# (ไมม่ ีForm 

Designer) เหมาะกบัคนทีคุ่น้กบั CLI 
ส่ิงท่ีต้องมีร่วมกนั 

 .NET SDK เวอรช์นัปัจจบุนั (เพยีงตดิตัง้ SDK กไ็ด ้dotnet CLI มาให)้ 
 โฟกสังาน Windows Desktop → ใช ้Visual Studio จะสะดวกกว่าอย่างชดัเจน 

 
5) การสร้างโปรเจก็ต์แรก (Console Application) 
วิธีท่ี 1: สร้างด้วย Visual Studio 

1. เปิด Visual Studio → Create a new project 
2. คน้หา/เลอืก Console App และเลอืกภาษา Visual Basic 
3. ตัง้ชื่อโปรเจก็ต ์(เช่น HelloVbNet) และโฟลเดอรป์ลายทาง → Create 
4. ใส่โคด้ต่อไปนี้ใน Module1.vb (หรอืไฟลห์ลกัที ่VS สรา้งให)้ 

Imports System 
 
Module Program 
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    Sub Main(args As String()) 
        Console.WriteLine("Hello, VB.NET!") 
        Console.Write("พมิพช์ื่อของคุณ: ") 
        Dim name As String = Console.ReadLine() 
        Console.WriteLine($"สวสัด ี{name}, ยนิดตีอ้นรบัสู่ VB.NET") 
        Console.WriteLine("กด Enter เพื่อออก...") 
        Console.ReadLine() 
    End Sub 
End Module 

5. กด F5 เพื่อ Run (Debug) หรอื Ctrl+F5 เพื่อ Run โดยไม ่Debug 
โครงสร้างโปรเจก็ต์ (โดยย่อ) 
HelloVbNet/ 
 ├─ HelloVbNet.vbproj   'ไฟลโ์ปรเจก็ต ์(SDK-style) 
 ├─ Module1.vb          'จดุเริม่โปรแกรม (Sub Main) 
 └─ My Project/         'ไฟลต์ัง้ค่า (บางเวอรช์นั) 
ตวัอยา่งไฟลโ์ปรเจก็ตแ์บบ SDK-style (อตัโนมตัจิาก VS/CLI): 
<Project Sdk="Microsoft.NET.Sdk"> 
  <PropertyGroup> 
    <OutputType>Exe</OutputType> 
    <TargetFramework>net8.0</TargetFramework> 
    <RootNamespace>HelloVbNet</RootNamespace> 
    <OptionStrict>On</OptionStrict> 
    <OptionInfer>On</OptionInfer> 
    <OptionExplicit>On</OptionExplicit> 
  </PropertyGroup> 
</Project> 
เคลด็ลบั: เปิด Option Strict/Infer/Explicit เป็น On เพื่อโคด้ทีช่ดัเจน ปลอดภยั และจบับัก๊ไดต้ัง้แต่ตอน
คอมไพล ์

 
วิธีท่ี 2: สร้างด้วย dotnet CLI (ใช้ได้ทัง้บน Windows/macOS/Linux) 

1. เปิด Terminal/Command Prompt แลว้รนั: 
dotnet new console -lang VB -n HelloVbNet 
cd HelloVbNet 
dotnet run 
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2. แกไ้ขไฟล ์Program.vb (หรอื Module1.vb แลว้แต่เทมเพลต) เป็นโคด้ตวัอยา่ง “Hello, 
VB.NET!” ดา้นบน จากนัน้ 

dotnet run 

 
เชก็ลิสตแ์นวปฏิบติัท่ีดีตัง้แต่วนัแรก 

 เปิด Option Strict On, Option Explicit On, Option Infer On 
 ตัง้ชื่อ Namespace/Class/Method/Property ใหส้ื่อความหมาย 
 แยก Layer ตัง้แต่เลก็ ๆ (เช่น ชัน้ส าหรบั Console/UI, ชัน้ส าหรบั Logic) 
 ใช ้NuGet จดัการไลบราร ี(เช่น System.Text.Json, Dapper, Serilog) 
 เริม่ฝึก Unit Test ตัง้แต่โปรเจก็ตเ์ลก็ (MSTest/xUnit + โครงสรา้งทีท่ดสอบได)้ 

 
Introduction to VB.NET (ฉบบัเชิงลึก) 
1) ประวติัและวิวฒันาการของ VB.NET (และส่ิงท่ีเกิด “ข้างใต้ฝากระโปรง”) 

 จาก VB6 → VB.NET (2002) 
VB.NET ถูกออกแบบใหมใ่หเ้ขา้กบั CLR (Common Language Runtime) ของ .NET: โคด้
จะคอมไพลเ์ป็น IL (Intermediate Language) เกบ็ใน Assembly (.exe/.dll) แลว้ถูก JIT 
(Just-In-Time) แปลงเป็นโคด้เครือ่งขณะรนัจรงิ → ได ้GC (Garbage Collector), Type 
Safety, Security และเขา้ถงึ Base Class Library (BCL) เดยีวกบั C# 

 ช่วง .NET 2.0–4.x 
เพิม่ Generics, Nullable, LINQ, Lambda, Async/Await, WinForms/WPF/ASP.NET 
ครบ—VB.NET ไดฟี้เจอรภ์าษาเรือ่ย ๆ (เช่น String Interpolation, Implicit Line Continuation) 

 ยคุ .NET Core → .NET 5+ (เรียกรวม “.NET”) 
รวมแบรนดเ์ป็น “.NET” เดยีว เน้น cross-platform, ประสทิธภิาพสูง, โปรเจกตแ์บบ SDK-
style (ไฟล ์.vbproj เรยีบงา่ย), เครือ่งมอื CLI (dotnet) 

 สถานะปัจจบุนัของ VB.NET 
o เหมาะกบั Windows Desktop (WinForms/WPF), Console, Library, งาน 

Enterprise/Legacy 
o เทมเพลต ASP.NET Core ไม่มีส าหรบั VB โดยปรยิาย (แต่ Library VB อา้งองิจาก

โครงการ C# ได)้ 
o จงัหวะเพิม่ฟีเจอรภ์าษา “ชา้กว่า C#” แต่เสถยีร ใชง้านระยะยาวไดด้ ี

คยีเ์วริด์เบือ้งลกึ: CLR / IL / JIT / GC / Assembly / BCL / SDK-style Project 
เขา้ใจสิง่เหล่านี้ = เขา้ใจ “เหตุผล” ของพฤตกิรรมภาษา, ประสทิธภิาพ, และการดบีกั 
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2) ความแตกต่างจาก VB6 (ย้ายบ้านอย่างปลอดภยั) 
ตารางสรปุประเดน็ทีส่่งผลต่อโคด้/สถาปัตยกรรมมากทีสุ่ด 

หวัข้อ VB6 VB.NET (แนะน าแนวทาง) 

รนัไทม ์ COM/ActiveX 
CLR + BCL (ปลดลอ็ก GC, Type Safety, 
Multithreading) 

Paradigm 
Event-driven, OOP ยงั
ไมเ่ตม็ 

OOP เตม็รปูแบบ (Class, Inheritance, 
Interface, Generics) 

ชนิดข้อมลู 
Variant ใชบ้่อย, Integer 
16 บติ 

Strongly Typed, Integer = 32 บิต, ใช ้
Object/Generic เมือ่จ าเป็น 

ข้อผิดพลาด On Error GoTo Try … Catch … Finally, Throw Exception 

อาเรย/์คอลเลกชนั มกัเริม่ index 1 
เริม่ 0-based; ใช ้List(Of T), Dictionary(Of 
TKey,TValue) 

UI VB6 Forms 
WinForms / WPF (Event/Delegate Model 
ต่างไป) 

ดีฟอลตพ์รอ็พเพอรตี์/late 
binding 

พบไดบ้่อย 
ปิด ดว้ย Option Strict On → โคด้ชดั/เรว็/
ปลอดภยักว่า 

ดีพลอย DLL Hell, regsvr32 
NuGet, ClickOnce/MSIX, Self-contained 
publish 

กบัดกัยอดฮิตเม่ือย้าย: 
1. Integer ของ VB.NET เป็น 32 บิต (เท่า Long ของ VB6) → ตรวจการแปลงชนิด 
2. เลกิ Default Property (เขยีนใหช้ดัเจน) 
3. ปิด Late Binding → เปิด Option Strict On เสมอ 
4. อเีวนต/์ดไีซน์เนอรข์อง WinForms/WPF ต่างจาก VB6—เรยีนรูแ้นวคดิ Event + Delegate 
5. COM Interop ยงัท าได ้แต่ควรจ ากดั/ห่อดว้ยชัน้ adapter เพื่อความปลอดภยัในระยะยาว 

 
3) .NET Framework, .NET Core, .NET 5+ (เลือกเส้นทางให้ถกูตัง้แต่วนัแรก) 

 .NET Framework 4.x (Windows-only): เหมาะกบัระบบเดมิทีพ่ึง่พา Windows/COM หนกั ๆ 
 .NET (5/6/7/8/9…): สายหลกัปัจจุบนั (ขอเรยีกสัน้ ๆ ว่า “.NET”) 

o Cross-platform (แต่ WinForms/WPF ยงั Windows-only) 
o โปรเจกตแ์บบ SDK-style, ใช ้CLI dotnet ได ้



ศูนยห์นงัสือราคานกัเรียน 

 

VB.NET Programming: Beginner หนา้ 8 

 

o TFM (Target Framework Moniker) เช่น net8.0, net8.0-windows (ส าหรบั 
WinForms/WPF) 

o VB.NET บน .NET: รองรบั Console, Class Library, WinForms/WPF อยา่งเป็น
ทางการ 

o ASP.NET Core: ไมม่เีทมเพลต VB (ปฏบิตัจิรงิมกัใช ้C# เป็น Host + อา้งองิ Library 
VB ได)้ 

ค าแนะน าการเลือก: 
 สรา้งของใหม ่→ เลอืก .NET เวอรช์นัล่าสดุท่ีเป็น LTS (เช่น .NET 8 LTS) 
 ตอ้ง UI เดสกท์อ็ป → net8.0-windows (หรอืเวอรช์นั LTS ปัจจบุนั) 
 ระบบเดมิบน .NET Framework → วางแผนยา้ยแบบเป็นเฟส: แยก Business Logic → 

Class Library (netstandard/netX) เพื่อรไีซเคลิในอนาคต 

 
4) เครื่องมือพฒันา: Visual Studio vs Visual Studio Code 
A) Visual Studio (แนะน าสดุส าหรบั VB.NET) 

 ครบทัง้ Form Designer, WPF Designer, Debugger, Profiler, Test Explorer 
 ขัน้ตอนตดิตัง้ (Community Edition กพ็อส าหรบัเริม่ต้น): 

1. ดาวน์โหลด Visual Studio → ตดิตัง้ Workload: .NET desktop development 
2. ถา้จะท าฐานขอ้มลู/SSDT ใหเ้พิม่ Data storage and processing 
3. เปิด Tools → Options → VB Defaults แลว้ตัง้คา่: 

 Option Strict = On 
 Option Explicit = On 
 Option Infer = On 

 ส่วนเสรมิทีเ่ป็นประโยชน์: Productivity Power Tools, .NET Analyzers 
B) Visual Studio Code 

 เบา คล่องตวั แต่ ไม่มี WinForms/WPF Designer ส าหรบั VB 
 ใชด้เีมือ่ท า Console/Library + เน้น CLI 
 ตอ้งตดิตัง้ .NET SDK และส่วนขยายพืน้ฐาน (แมช้ื่อจะเน้น C# แต่ช่วยเรือ่ง 

Debug/Test/OmniSharp) 
ร่วมกนัต้องมี: 

 .NET SDK เวอรช์นัล่าสุด (จะได้ dotnet CLI มาดว้ย) 

 
5) สร้างโปรเจกตแ์รก (Console) + เข้าใจโครงสร้างโปรเจกตเ์ชิงลึก 
วิธีท่ี 1: Visual Studio 



ศูนยห์นงัสือราคานกัเรียน 

 

VB.NET Programming: Beginner หนา้ 9 

 

1. Create a new project → เลอืก Console App (Visual Basic) 
2. ตัง้ชื่อเช่น HelloVbNet → Create 
3. เปิดไฟล ์Module1.vb (หรอื Program.vb) แลว้ใส่โคด้: 

Imports System 
Imports System.Text 
 
Module Program 
    Sub Main(args As String()) 
        ' ใหค้อนโซลรองรบั UTF-8 (เหมาะกบัขอ้ความภาษาไทย) 
        Console.OutputEncoding = Encoding.UTF8 
        Console.InputEncoding = Encoding.UTF8 
 
        Console.WriteLine("Hello, VB.NET on .NET!") 
        Console.Write("พมิพช์ื่อของคุณ: ") 
        Dim name As String = Console.ReadLine() 
 
        ' String interpolation (VB 14+): ใช ้$"..." 
        Console.WriteLine($"สวสัด ี{name}, ยนิดตีอ้นรบัสู่ VB.NET") 
        Console.WriteLine($"เวลาปัจจบุนั: {DateTime.Now}") 
        Console.WriteLine("กด Enter เพื่อออก...") 
        Console.ReadLine() 
    End Sub 
End Module 

4. กด F5 (Debug) หรอื Ctrl+F5 (Run) 
โครงสร้างโปรเจกต์ (ส าคญัต่อการดแูลระยะยาว) 
HelloVbNet/ 
 ├─ HelloVbNet.vbproj      ' SDK-style project 
 ├─ Program.vb (หรอื Module1.vb) 
 └─ My Project/            ' การตัง้ค่าบางอย่าง (บางเทมเพลต) 
ตวัอยา่ง .vbproj ที ่“ดตีัง้แต่ตน้” (ปรบัไดเ้อง): 
<Project Sdk="Microsoft.NET.Sdk"> 
  <PropertyGroup> 
    <OutputType>Exe</OutputType> 
    <TargetFramework>net8.0</TargetFramework> 
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    <RootNamespace>HelloVbNet</RootNamespace> 
 
    <!-- ช่วยใหโ้คด้ปลอดภยั/ชดัเจน --> 
    <OptionStrict>On</OptionStrict> 
    <OptionExplicit>On</OptionExplicit> 
    <OptionInfer>On</OptionInfer> 
 
    <!-- เปิดค าเตอืนใหเ้ขม้งวดขึน้ ถา้ตอ้งการคุณภาพโคด้ --> 
    <WarningsAsErrors>NU1605;BC42024</WarningsAsErrors> 
    <TreatWarningsAsErrors>false</TreatWarningsAsErrors> 
  </PropertyGroup> 
</Project> 
หมายเหตุ: VB.NET ไม่มี “top-level statements” แบบ C#—จดุเริม่ตน้ยงัคงเป็น Sub Main ใน 
Module หรอืใช ้Application Framework ของ WinForms 
วิธีท่ี 2: dotnet CLI (Windows/macOS/Linux) 
dotnet new console -lang VB -n HelloVbNet 
cd HelloVbNet 
dotnet run 

 แก ้Program.vb ดว้ยโคด้ดา้นบน แลว้ dotnet run อกีครัง้ 
 ใช ้dotnet build เพื่อคอมไพล,์ dotnet publish เพื่อแพก็ไปปล่อยใชง้าน 

o ตวัอยา่ง publish แบบ self-contained (ไมต่อ้งตดิตัง้ .NET Runtime ทีเ่ครือ่ง
ปลายทาง): 

o dotnet publish -c Release -r win-x64 --self-contained true 
/p:PublishSingleFile=true 

 
เคลด็ลบัคณุภาพ/ประสิทธิภาพตัง้แต่วนัแรก 

 เปิด Option Strict/Explicit/Infer = On → ลด late binding, เพิม่ความเรว็ & ความชดัเจน 
 ตัง้ Console.Input/OutputEncoding = UTF8 เมือ่มภีาษาไทย 
 แยก ชัน้ UI/Logic แมเ้ป็นโปรเจกตเ์ลก็ ๆ (เช่น Program.vb เรยีกฟังก์ชนัจาก 

Services/Greeter.vb) เพื่อฝึกโครงสรา้งทีท่ดสอบง่าย 
 ใช ้NuGet ตัง้แต่ตน้ (เช่น Serilog ส าหรบัลอ็ก, System.Text.Json ส าหรบั JSON, Dapper 

ส าหรบั data access เบือ้งตน้) 
 ใช ้Analyzers และ “Warnings as Errors” เฉพาะบางรหสัทีอ่ยากเขม้งวด เพื่อกนัหน้ีเทคนิค 
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สรปุใจความส าคญั 

 VB.NET รนับน CLR: ได ้GC, IL, JIT, Type Safety, ไลบรารรีว่มกบั C# 
 ต่างจาก VB6 อยา่งมนีัยส าคญั: Strong typing, OOP เตม็รปูแบบ, Exception-based error 

handling, 0-based array 
 ยคุปัจจบุนัใหเ้ลอืก .NET (LTS), โดย VB.NET เหมาะกบั Console/Library/WinForms/WPF 

(Windows) 
 เครือ่งมอืแนะน า: Visual Studio + .NET SDK, เปิด Option Strict/Explicit/Infer 
 เริม่ดว้ย Console App → เขา้ใจโครงสรา้งโปรเจกต/์TFM/CLI → ปพูืน้สู่บทต่อไป 

 
ประวติัและวิวฒันาการของ VB.NET 
ประวติัและวิวฒันาการของ VB.NET ผมจะอธบิายเชงิลกึ ครอบคลุมตัง้แต่ตน้ก าเนิด Visual Basic 
จนถงึยคุ .NET 5+ 

 
� ประวติัและวิวฒันาการของ VB.NET 
1. จดุเร่ิมต้นของ Visual Basic (ก่อน VB.NET) 

 Visual Basic (VB) ก าเนิดครัง้แรกในปี 1991 โดย Microsoft 
 ออกแบบมาเพื่อใหง้า่ยต่อการพฒันาแอปพลเิคชนั Windows Desktop 
 VB ใชแ้นวคดิ RAD (Rapid Application Development) → พฒันาโปรแกรมไดเ้รว็มาก 

เพราะม ีGUI Designer (ลากปุ่ ม, วาง Label, สรา้ง Form) 
 จดุแขง็ของ VB ดัง้เดิม (VB1 – VB6) 

o เขา้ใจง่าย แมผู้เ้ร ิม่ต้นเขยีนโคด้ครัง้แรกกเ็รยีนรูไ้ดเ้รว็ 
o ท างานรว่มกบั Windows API และ COM ไดง้า่ย 
o ไดร้บัความนิยมสงูสุดในยคุ 1990s – early 2000s 

� VB6 (1998) คอืเวอรช์นัสุดทา้ยของ Visual Basic แบบคลาสสกิ ก่อนเขา้สู่ยคุ .NET 

 
2. การเกิดของ VB.NET (2002) 

 Microsoft เปิดตวั .NET Framework 1.0 (2002) 
 VB ไดถู้กออกแบบใหมท่ัง้หมด กลายเป็น VB.NET 
 เปลีย่นแปลงส าคญั: 

o ไมร่องรบั Backward Compatibility กบั VB6 โดยตรง 
o กลายเป็น ภาษาเชิงวตัถเุตม็รปูแบบ (Fully Object-Oriented Language) 
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o ใช ้CLR (Common Language Runtime) → ท าใหท้ างานรว่มกบัภาษาอื่นใน .NET 
(C#, F#, C++/CLI) ได ้

o สนบัสนุนคุณสมบตัใิหม ่เช่น: 
 Inheritance (การสบืทอดคลาส) 
 Exception Handling (Try…Catch) 
 Garbage Collection (จดัการหน่วยความจ าอตัโนมตั)ิ 
 Asynchronous Programming (ภายหลงัเพิม่ใน VB.NET 2012+) 

 
3. วิวฒันาการของ VB.NET แต่ละเวอรช์นัหลกั 
� VB.NET 2002 – 2003 

 เปิดตวัพรอ้ม .NET Framework 1.0 – 1.1 
 สนบัสนุน OOP อยา่งเตม็รปูแบบ 
 ยงัขาดคุณสมบตัหิลายอยา่ง เช่น Generics 

� VB.NET 2005 
 มาพรอ้ม .NET Framework 2.0 
 เพิม่ Generics, Partial Classes, Nullable Types 
 รองรบั Windows Forms และ Web Forms 

� VB.NET 2008 
 มาพรอ้ม .NET Framework 3.5 
 รองรบั LINQ (Language Integrated Query) และ Lambda Expressions 

� VB.NET 2010 
 มาพรอ้ม .NET Framework 4.0 
 เพิม่ Auto-Implemented Properties, Collection Initializers 
 สนบัสนุน Parallel Programming (Task Parallel Library) 

� VB.NET 2012 – 2015 
 รองรบั Async / Await → เขยีนโปรแกรมแบบ Asynchronous งา่ยขึน้ 
 รองรบั WinRT API ส าหรบั Windows 8 / UWP 

� VB.NET 2017 – 2019 
 ปรบัใหท้ างานรว่มกบั .NET Core ได ้
 Microsoft ลดการลงทุนในการพฒันา VB.NET ต่อ แต่ยงัคงรองรบั 

� ปัจจบุนั (VB.NET บน .NET 5/6/7/8) 
 สามารถท างานบน .NET 5+ (Unified Platform) 
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 VB.NET ยงัอยู ่แต่ Microsoft ประกาศว่าเน้น Maintenance Mode → ไมเ่พิม่ฟีเจอรใ์หม่
แลว้ 

 ใชไ้ดก้บั Windows Desktop Apps (WinForms, WPF) เป็นหลกั 
 ในงาน Cross-platform (Linux, macOS, Web, Mobile) → Microsoft แนะน าใหใ้ช ้C# 

 
4. เหตผุลท่ี VB.NET ส าคญัในวงการ 

 เป็นภาษาทีช่่วยใหผู้เ้ร ิม่ตน้เขยีนโคด้ง่าย แต่กม็พีลงัมากพอส าหรบังานจรงิ 
 ถูกใชก้วา้งขวางใน Enterprise Applications (โดยเฉพาะในองคก์รทีใ่ช ้Windows Server) 
 ยงัม ีLegacy Code จ านวนมากทีเ่ขยีนดว้ย VB.NET → ตอ้งการ Developer ทีเ่ขา้ใจ 

 
� สรปุ 

 VB (Visual Basic) → เริม่ตน้ปี 1991, เน้น RAD 
 VB6 (1998) → จดุสงูสุดของ VB แบบดัง้เดมิ 
 VB.NET (2002) → เปลีย่นแปลงครัง้ใหญ่, รองรบั OOP เตม็รปูแบบ, ท างานบน .NET CLR 
 VB.NET + .NET 5+ (ปัจจบุนั) → ยงัใชไ้ด ้โดยเฉพาะ Windows Desktop Apps, แต่ 

Microsoft เน้นใหใ้ช ้C# เป็นหลกัส าหรบังานใหม่ 

 
ความแตกต่างระหว่าง VB6 และ VB.NET  

 
1. สถาปัตยกรรม (Architecture) 

 VB6 
o เป็นภาษา COM-based (Component Object Model) 
o ท างานบน Windows เท่านัน้ 
o โปรแกรมทีเ่ขยีน VB6 จะต้องอาศยั VB Runtime (เช่น MSVBVM60.DLL) 

 VB.NET 
o เป็นภาษา Managed Code ท างานบน .NET CLR (Common Language Runtime) 
o ม ีCross-platform ได ้(ถา้ใช ้.NET Core หรอื .NET 5+) 
o ไมข่ึน้อยูก่บั COM โดยตรง แต่สามารถท างานรว่มกบั COM ได ้

 
2. Paradigm การเขียนโปรแกรม 

 VB6 
o เป็น Event-driven programming ส าหรบั Windows Form 
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o รองรบั OOP แบบบางส่วน (Encapsulation, Inheritance ผ่าน Interface เท่านัน้, ไมม่ ี
Polymorphism ทีแ่ทจ้รงิ) 

 VB.NET 
o เป็น Object-Oriented Programming (OOP) เตม็รปูแบบ 
o รองรบั Class, Inheritance, Polymorphism, Interfaces ไดค้รบถว้น 
o รองรบั Generics, LINQ, และ Asynchronous programming 

 
3. Compilation และ Execution 

 VB6 
o คอมไพลเ์ป็น Native Code หรอื P-code (Pseudo Code) 
o ท างานโดยตรงบน Windows OS 

 VB.NET 
o คอมไพลเ์ป็น Intermediate Language (IL) 
o CLR แปลง IL เป็น Native Code ตอน Runtime (JIT – Just-In-Time compilation) 
o ท าให ้Cross-language Integration เป็นไปได ้(เช่น เขยีน VB.NET รว่มกบั C#, F# 

ได)้ 

 
4. GUI และ Forms 

 VB6 
o ใช ้Windows Forms แบบดัง้เดิม ทีผ่กูตดิกบั Win32 API 
o ออกแบบ GUI ไดง้า่ย แต่จ ากดัเฉพาะ Windows 

 VB.NET 
o รองรบั Windows Forms, WPF (Windows Presentation Foundation), UWP 

(Universal Windows Platform) 
o GUI มคีวามยดืหยุน่มากกว่า และรองรบั XAML 

 
5. Type System และการจดัการ Memory 

 VB6 
o Weakly typed: สามารถใช ้Variant type ทีไ่มแ่น่นอนได ้
o ไมม่ ีGarbage Collection (นกัพฒันาตอ้งจดัการ memory และ object references 

เอง) 
 VB.NET 

o Strongly typed: ม ีtype-checking ทีช่ดัเจน 
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o CLR จดัการ Garbage Collection (GC) ใหอ้ตัโนมตั ิ
o ปลอดภยักว่าในแงข่อง memory leaks และ dangling pointers 

 
6. การเช่ือมต่อฐานข้อมลู 

 VB6 
o ใช ้ADO (ActiveX Data Objects) 
o มขีอ้จ ากดัเรือ่งความยดืหยุ่นและ performance 

 VB.NET 
o ใช ้ADO.NET, Entity Framework, LINQ to SQL 
o จดัการการเชื่อมต่อขอ้มลูไดท้นัสมยัและรองรบัหลายรปูแบบ (SQL Server, MySQL, 

Oracle, etc.) 

 
7. ความสามารถใหม่ใน VB.NET ท่ีไม่มีใน VB6 

 Exception Handling ดว้ย Try...Catch...Finally 
 Inheritance (class-based) 
 Generics 
 Attributes & Reflection 
 Asynchronous Programming (Async / Await) 
 LINQ (Language Integrated Query) 
 Multi-threading ทีง่า่ยขึน้ 

 
8. การ Support 

 VB6: Microsoft หยดุสนบัสนุนแลว้ (ตัง้แต่ปี 2008) แต่ยงัม ีRuntime รองรบับน Windows 
 VB.NET: ยงัมกีารสนบัสนุนใน .NET Framework และ .NET 5+, แต่ Microsoft ประกาศว่า 

VB.NET จะไมพ่ฒันา feature ใหมม่ากนกั (focus อยูท่ี ่C#) 

 
� สรปุสัน้ๆ 

 VB6 = งา่ย, เรว็ส าหรบั Windows Form เลก็ๆ, แต่จ ากดัมาก 
 VB.NET = เป็นภาษา OOP เตม็รปูแบบ, ท างานบน .NET CLR, ทนัสมยัและยดืหยุน่กว่า 

 
NET Framework, .NET Core และ .NET 5+ 
NET Framework, .NET Core และ .NET 5+ เป็นหวัใจส าคญัในการเขา้ใจ VB.NET เพราะภาษา 
VB.NET ท างานอยูบ่น .NET Platform ซึง่มวีวิฒันาการอยา่งต่อเนื่องตัง้แต่ยคุแรกจนถงึปัจจบุนั 
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� .NET Framework 

 เปิดตวัปี 2002 พรอ้มกบั VB.NET และ C# 
 เป็น Windows-only platform 
 ใช ้CLR (Common Language Runtime) ส าหรบัจดัการ memory, garbage collection, JIT 

compilation 
 ม ีBase Class Library (BCL) และ Framework Class Library (FCL) ทีร่วมคลาสและ API 

ส าหรบังานต่างๆ เช่น IO, Collections, XML, ADO.NET 
 เหมาะกบัการพฒันา Desktop Application (Windows Forms, WPF) และ ASP.NET Web 

Forms/MVC 
 ข้อจ ากดั: 

o รนัไดเ้ฉพาะ Windows 
o การอปัเดตขึน้กบั Windows Update 
o ไมย่ดืหยุน่ส าหรบั cross-platform 

 
� .NET Core 

 เปิดตวัปี 2016 (Microsoft Build) 
 เป็น cross-platform → ท างานไดท้ัง้ Windows, Linux, macOS 
 ออกแบบใหเ้ป็น Open Source บน GitHub → community มสี่วนรว่ม 
 ใช ้CoreCLR ซึง่เบากว่า CLR ของ .NET Framework 
 ม ีCoreFX library ทีแ่ยกส่วนเลก็ กระทดัรดั และโหลดเฉพาะทีจ่ าเป็น 
 รองรบั modern development เช่น microservices, Docker, Kubernetes 
 รองรบั VB.NET, C#, F# (แต่ VB.NET ถูกลดการสนบัสนุนในบางฟีเจอรใ์หม)่ 
 ข้อดี: 

o เรว็กว่า .NET Framework 
o Deploy แบบ self-contained ได ้(ไมต่อ้งตดิตัง้ runtime แยก) 
o อปัเดต release cycle เรว็กว่า 

 
� .NET 5+ (Unified Platform) 

 เปิดตวั พฤศจิกายน 2020 
 Microsoft รวม .NET Framework + .NET Core + Xamarin + Mono → เป็น .NET Unified 

Platform 
 ตัง้แต่ .NET 5 เป็นตน้ไปจะใชช้ื่อเพยีง “.NET” ไมใ่ช ้“Core” อกี 
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 รองรบัทุก platform: Web, Desktop, Mobile, Cloud, IoT, Gaming 

 ใช ้Single BCL (Base Class Library) ที統่一กนัหมด 
 ใช ้RyuJIT compiler ทีป่รบัปรงุ performance อยา่งมาก 
 Roadmap: 

o .NET 5 → รุน่ transition 
o .NET 6 (LTS) → ปลายปี 2021 
o .NET 7, 8, 9 … → ออกทุกปี (รุน่คู่เป็น LTS) 

 VB.NET บน .NET 5+: 
o Microsoft ประกาศว่า VB.NET จะยงัคงอยู่ แต่ไม่พฒันา feature ใหม่ 
o เหมาะส าหรบัการ maintenance legacy project 
o ฟีเจอรใ์หมส่่วนใหญ่จะไปที่ C# 

 
� ตารางสรปุเปรียบเทียบ 

คณุสมบติั .NET Framework .NET Core .NET 5+ 

ปีเปิดตวั 2002 2016 2020 

ระบบปฏบิตักิารรองรบั Windows เท่านัน้ Windows, Linux, macOS Cross-platform (Unified) 

Open Source � � � 

Performance ปานกลาง สงู สงูมาก 

Deployment Global install Self-contained / Portable Self-contained / Portable 

สนบัสนุน VB.NET � เตม็รปูแบบ � แต่จ ากดั � (เฉพาะ legacy) 

สถานะ Legacy Active แต่ถูกรวม Unified main platform 

 
� บทสรปุ 

 ถา้เป็น โปรเจก็ต์เก่า (Legacy Windows App) → ใช ้.NET Framework + VB.NET 
 ถา้เป็น โปรเจก็ต์ใหม่ Cross-Platform → ควรใช ้.NET 6/7/8 (VB.NET ยงัใชไ้ด ้แต่ไม่

แนะน าส าหรบังานใหม ่→ ควรใช ้C#) 
 อนาคตของ VB.NET: 

o Microsoft จะยงั ซพัพอรต์ แต่เน้น stability ไมเ่น้น feature ใหม่ 
o เหมาะกบัองคก์รทีม่โีคด้เดมิ (legacy system) 
o นกัพฒันาทีเ่ริม่ตน้ใหมค่วรเรยีน C# เป็นหลกั 
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การติดตัง้ Visual Studio / Visual Studio Code ส าหรบั VB.NET 
การติดตัง้ Visual Studio / Visual Studio Code ส าหรบั VB.NET เป็นสิง่ส าคญัมาก เพราะเครือ่งมอื
พฒันา (IDE) จะก าหนด workflow และ productivity  ตัง้แต่แรก 

 
� 1. Visual Studio (IDE แนะน าส าหรบั VB.NET) 
Visual Studio เป็น IDE ทีค่รบเครือ่งทีสุ่ดส าหรบั VB.NET ทัง้ Console, Windows Forms, WPF และ 
Class Library 

 
ขัน้ตอนติดตัง้ Visual Studio 
A) ดาวน์โหลด 

1. เขา้เวบ็ไซต:์ Visual Studio Download 
2. เลอืก Community Edition (ฟรสี าหรบันกัเรยีน/นกัพฒันาอสิระ) หรอื 

Professional/Enterprise 

 
B) ติดตัง้ Workload 
หลงัจากเปิดตวัตดิตัง้: 

1. เลอืก Workloads → ส าหรบั VB.NET เลอืก 
o .NET desktop development → ส าหรบั Windows Forms, WPF, Console, Class 

Library 
2. ตวัเลอืกเสรมิ (Optional) 

o Universal Windows Platform development → ถา้ตอ้งการ UWP 
o ASP.NET and web development → ถา้ตอ้งการเวบ็ (แต่ VB.NET ไมค่่อยใช)้ 
o Data storage and processing → ส าหรบัฐานขอ้มลู / SQL Server 

 
C) ตวัเลือกส าคญัหลงัติดตัง้ 

 Tools → Options → VB Defaults 
o Option Strict = On → ป้องกนั late binding 
o Option Explicit = On → บงัคบัประกาศตวัแปร 
o Option Infer = On → ช่วยให ้type inference ชดัเจน 

 Extensions 
o Productivity Power Tools, Code analyzers, NuGet package manager 

 
D) สร้างโปรเจก็ต ์VB.NET 

https://visualstudio.microsoft.com/downloads/
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1. File → New → Project 
2. เลอืก Console App (.NET) หรอื Windows Forms App (.NET) 
3. ตัง้ชื่อโปรเจก็ต ์→ สรา้งไฟล ์Program.vb หรอื Form1.vb 

 
� 2. Visual Studio Code (เบา, CLI-based) 
VS Code เป็น editor เบาๆ ทีร่องรบัหลายภาษาและ platform cross-platform 

 เหมาะส าหรบั: 
o Console Application 
o Class Library 
o การใช ้dotnet CLI 

 
ขัน้ตอนติดตัง้ VS Code + VB.NET 
A) ดาวน์โหลด 

 VS Code Download → ตดิตัง้ตาม OS 
B) ติดตัง้ .NET SDK 

 ดาวน์โหลด .NET SDK ล่าสุด: dotnet.microsoft.com/download 
 ตรวจสอบเวอรช์นั: 
 dotnet --version 

C) Extension ส าคญั 
 C# extension (OmniSharp) → สนบัสนุน IntelliSense, Debug 
 VB.NET → ใชไ้ดก้บั C# extension เพราะใช ้.NET SDK รว่มกนั 

D) การสร้างโปรเจก็ต์ 
# สรา้งโปรเจก็ต ์Console VB.NET 
dotnet new console -lang VB -n HelloVbNet 
cd HelloVbNet 
dotnet run 

 แกไ้ข Program.vb ผ่าน VS Code 
 ใช ้dotnet build เพื่อคอมไพล ์
 ใช ้dotnet publish เพื่อเผยแพร ่(publish) 

 
� เปรียบเทียบ Visual Studio กบั VS Code 

ฟีเจอร ์ Visual Studio Visual Studio Code 

Debugger ครบเครือ่ง ตอ้งตดิตัง้ extension 

https://code.visualstudio.com/Download
https://dotnet.microsoft.com/en-us/download
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ฟีเจอร ์ Visual Studio Visual Studio Code 

Designer (WinForms/WPF) � GUI Designer � ไมม่ ีGUI Designer 

IntelliSense � สมบรูณ์ � ตอ้งผ่าน extension 

Project Templates � ครบทุกชนิด � แต่จ ากดั 

Cross-platform � Windows เท่านัน้ � Windows/Linux/macOS 

CLI ใชไ้ด ้ � ใช ้dotnet CLI เตม็รปูแบบ 

 
� สรปุแนวทางการติดตัง้ 

 แนะน าเร่ิมต้น: Visual Studio Community Edition 
o เหมาะส าหรบัเรยีนรูแ้ละพฒันา VB.NET Desktop / Console แบบเตม็รปูแบบ 

 ถ้าเน้นเบา, Cross-platform, CLI: VS Code + .NET SDK 
 เปิด Option Strict/Explicit/Infer ตัง้แต่เริม่ → ลด bug, เพิม่ประสทิธภิาพ 

 
การสรา้งโปรเจก็ตแ์รก (Console Application) ด้วย VB.NET  

 
� 1. สร้างโปรเจก็ต ์Console Application บน Visual Studio 
A) ขัน้ตอน 

1. เปิด Visual Studio → File → New → Project 
2. เลอืก Console App (.NET) → ภาษา Visual Basic 
3. ตัง้ชื่อโปรเจก็ต ์เช่น HelloVBNet 
4. เลอืกโฟลเดอรเ์กบ็โปรเจก็ต์ → กด Create 

 
B) โครงสร้างโปรเจก็ต์ (พื้นฐาน) 
เมือ่สรา้งเสรจ็ จะไดไ้ฟลแ์ละโฟลเดอรป์ระมาณนี้: 
HelloVBNet/ 
├─ HelloVBNet.vbproj       # ไฟล ์project ของ VB.NET 
├─ Program.vb              # ไฟลห์ลกัของโปรแกรม 
└─ bin/obj                 # Output / build files 

 
C) ตวัอย่างโค้ด Program.vb แบบพื้นฐาน 
Module Program 
    Sub Main() 


	FP
	0_คำนำ
	0_สารบัญ
	บทที่ 1

